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Exercise 4 - Focus on Data

Objectives: As the title suggests, this section requires you to get involved with the data side of GIS
operations, in all its various forms. Accurate, stable data is the bedrock on which insightful analysis is
produced. In this exercise we’ll learn about...

e QGIS Data Management functionality
e Using the Plugins manager to access online earth imagery data (openLayers)
e Organising and preparing non-spatial table data and bringing it into QGIS

Please ask if there is anything you don’t understand!

Part 1 — Opening QGIS Browser

QGIS comes with a standalone application called QGIS Browser that is useful for managing and
viewing your spatial data’s metadata

1) Open QGIS Browser using the windows start menu
Start > All Programs > QGIS 2.18 > QGIS Browser 2.18.10 Please note the name of the
browser will vary according to your installed version of QGIS

B ccis2.18
4 GRASS GIS 7.2.1
() OSGeodW Shell
#% QGIS Browser 2.18.10
RSl OG!S Browser 2.18.10.
{¢ QGIS Desktop 2.18.10
{# OGIS Desktop 2.18.10 with GRASS
{¢ Ot Designer with QGIS 2.18.10 cus
E SAGAGIS (23.2)
() Setup

l Simplenote

l Start-up
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The browser should appear as shown below
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Within the file explorer panel navigate to:
C:\Intro_Quantum_GIS\Exercises\Data\Vector

Select places.shp and then step through the 3 accessible tabs: metadata, Preview and
Attributes; this is very useful outline information for datasets. QGIS Browser is

particularly useful if you have a large volume of data to review.
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- Try using the browser to explore some of the other vector and raster datasets.

Part 2 — The Open Layers Plugin

- Returning to QGIS desktop, open Exercise_4.qgs from C:\Intro_Quantum_GIS\Exercises\.
You are looking at Tanzania with some settlement, road and river data, sourced from
Open Street Map.

# QGIS 21813 - Exercise 4
Project Edit View Layer Settings Plugins Vector Rester Datsbase Web Processing Help

DEBRLEN 6 &-K

vy J | 5 -
Layars Panel &%

Vo waevo-s -

';,- 13 [ 0sM data

’ X + plces

a X 0SM_TZA rivers

- %/ 0osM TZA roads
< K = primary
(R M — sacondary
' x Tanzania_adm3

& |9 [ rusnane

- 3 [ Truemarble

¥~ a0 msc

,l:

W3

Vo~

#=

=

i

E: Spatal Bookmarks Panel ox)

\P ome<

& reme [erogect T

8 Isiolo County  Exercise_3.q0s 36

)
o '_'_\\LJ_

e

Coordinate 30.25,-12.04 W soale|1:6558,728 | 4 Magnifier 100%

- We will now add some background mapping to give the data some context. We will do
that using the OpenLayers plugin

- From the Plugins drop-down menu click Manage and Install Plugins

m Vector Raster Databas

*"+ Manage and Install Plugins...

l'i:, Python Console
GRASS G
Metatools r
OpenLayers plugin ¥
Profile Tool ¢

- Type Openlayers into the search bar
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# Plugins | Al (511) ? b
Search | openlayers a

&AII

| & )
F -: Installed

.

Not installed

ﬁ Settings

++ Mapzen Isochrones
4y OGR2Layers

44 qgis2web
4 QOsM
- TM5 for Korea

J

V'ﬂlis plugin is trusted
OpenlLayers Plugin

Google Maps, Bing Maps,
OpenStreetMap layers and more

71017 rating vote(s), 1585953 downle

Tags: google,osm,openlayers,stamen,bing
More info: homepage bug tracker
code repository

Author: Sourcepole

Available version: 1.4.3 (in QGIS Official Plugin
Repository)

(1 | 1

Upgrade all Install plugin

Close Help

- Select the OpenLayers Plugin and then click install plugin
- QGIS will download and install the plugin

- Close the Plugins window

Part 3 — Configuring coordinate reference systems to accurate display data

We must now ensure that ‘on the fly’ CRS transformation is enabled

- From the project menu select project properties
- Click on the CRS (Coordinate Reference System) tab and make sure that Enable ‘on the

fly’ CRS transformation is ticked.
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# Project Properties | CRS ? *
® Enable 'on the fly' CR5 transformation (OTF) ]
Filter
Recently used coordinate reference systems
| Coordinate Reference System Authority ID
* Generated CRS (+proj=tmerc Hat_0=4% Hon_0=-2 +k=0.999601272 +x_0=40... USER:100003
* Generated CRS (+proj=tmerc Hat_0=4% Hon_0=-2 +k=0.9996012717 +x_0=4.. USER:100002
* Generated CRS (+proj=tmerc Hat_0=4% Hon_0=-2 +k=0.999601272 +x_0=40... USER.:100001
* Generated CRS (+proj=merc +a=6378137 +b=6378137 +at_ts=0.0 Hon_0=0.... USER:100000
WGS 84 / UTM zone 37N EP5G: 32637
WGES 84 / Pseudo Mercator EPSG: 3857
WGS 84 EPSG:4325
Macros
Relations
(] (K10
Coordinate reference systems of the world Hide deprecated CRSs
| Coordinate Reference System Authority ID [;]
~ Unknown datum based upon the War Office ellipscid EPSG:4029
- Unspecified datum based upon the Clarke 1866 Authalic Sphere EPSG: 4052
-~ Unspecified datum based upon the GRS 1980 Authalic Sphere EPSG: 4047 |:|
- Unspecified datum based upon the Hughes 1980 ellipsoid EPSG: 4054
- Unspecified datum based upon the International 1524 Authalic Sphere EPSG:4053
< Uranus 2000 TAL2000:79900
- VN-2000 EP5G:4756
- Vanua Levu 1915 EPSG:4748
-~ Venus 2000 TALIZ2000:29500
- Vientiane 1982 EPSG:4675
- Viti Levu 1912 EP5G:4752
- Viti Levu 1916 EP5G:4731
~ Voirol 1875 EPS5G:4304
- Vigirol 1875 (Paris) EPSG:4811
~Voirol 1879 EPS5G:4671
~Voirol 1879 (Paris) EPSG:4821
< WES B8 EPSG:4760
- WG5 72 EP5G:4322
- W@ES T2BE EP5G:4324 E
- WGES 84 EPSG:4325
Kl | [«]r)

Selected CRS: | WGS 84

+proj=longlat +datum="WGS84 +no_defs

- This needs to be ticked because you are about to add some background mapping to your
QGIS project which uses a different coordinate system to the data which is currently
loaded.

- Press OK.
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Part 4 - Display OpenLayers background mapping.

- From the web menu expand the OpenLayers Plugin

7
Web | Processing Help
MetaSearch ¢ ™ N oy [

OpenlLayers Overvi

Ew

e

Terms of Service / About

11

Sout

H,INI\-"[RSIT Y OF

ampton

;E_‘ OpenStreetMap ’

g"’ Google Maps r

— Bing Maps r
— O5M/Stamen r
Wikimedia Maps r

QSM/Thunderforest r

D% &

Apple Maps r
/ > !

- You can choose to display any of the available background maps; try Google Hybrid or
Bing Aerial with Labels

- The imagery will be streamed into your project as a new layer, the speed of rendering
will depend on your internet connection speed

- You may need to move the new layer around in the layers panel to ensure the drawing
order is correct.

- Try panning and zooming around your map

- remember to turn layers on and off as you require; having too many background
mapping layers turned on at once may affect performance and rendering speed.
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Froject Edit View

H R

x osM data
X« places
0SM_TZA_rivers.
x OSM_TZA_roads

Ls |
soatalBonkrarks panel @1/ 08

¥ o=

B |neme

siola Courty

ot | 8
Suerdse_3.q08 36

I X Render & EPSG:3857 [OTF)

EES

@

Page 6 of 13




wé’é'g S UMNIVERSITY OF
FLOWMINDER.ORG outhampton
Challenge:

Return to the Manage and Install Plugins window (Plugins drop-down menu). If permissions for your
PC enable you to do so, search for and Install QuickOSM; Once installed, go to the Vector drop-down
menu and select Quick OSM. Try running a query to download some Open Street Map data.

Explore other plugins that are available and relevant to your interests.

Part 5 — Data preparation: joining population data to boundaries

Both this section and the following section look at two types of raw table data which are commonly
used in GIS analysis. Both data types require some preparation before GIS analysis can take place;
we will now go through these processing steps.

In this section we will run through the process of joining non-spatial population and demographic
data for districts in Tanzania to corresponding spatial data features, in this case district boundaries
for Tanzania. The data originates from the United States Census Bureau and is freely available from
the DHS Spatial Data Repository (https://spatialdata.dhsprogram.com/home/).

1. In Windows Explorer Locate the following CSV data file and open it in Microsoft Excel or
Notepad; then inspect the data:

C:\Intro_Quantum_GIS\Exercises\Data\Tables\TZA_adm2_pop.csv

Now return to QGIS and locate the dataset Tanzania_adm2 in your Layers Panel. Right-click the
layer and Open Attribute Table. Looking at this boundary data and the population data, can you
identify a common field to both tables on which we could join them? They both have one field
named GEO-MATCH. You will now join these two tables based on this field.

2. Bring the population data TZA_adm2_pop.csv into QGIS.
— Locate the CSV file, via QGIS Browser or Windows Explorer, and drag it into the map
window

— Notice the alternative icon for table data (sometime known as non-spatial data) F

[

Layers Panel

o [ ® T ! 8

» |

X [l OSM data
- TZIA

e[

__adm2_pop I

Tanzania adm2
[l HILLSHADE =
[0 TrueMarble
[l misc
Bing Aerial with labels
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3. Configure the Join

— Right-click the spatial boundary dataset Tanzania_adm2 and click Properties; these

are Tanzanian administrative boundary data from United States Census Bureau
— Click on the Joins tab.

— Click on the green plus sign

|Join layer IJoin field |Target field Memory cache Prefix Joined fields

Rendering

, Dizplay

UG Actions = J
L i -
6 Jainis a Style

0K Cancel Apply Help

— A new window will appear.

— Select TZA_adm2_pop as the Join Layer.

— Select GEO_MATCH as the Join and Target field

Tick Custom field name prefix and delete all text (N.B. if this text is not deleted,
each new joined field will have the prefix ‘TZA_adm2_pop_’ — this is a nuisance!

¥ Add vector join @

Join layer lj TZA_adm2_pop -
Join field abc GEO_MATCH -
Target field abc GEO_MATCH -

X Cache join layer in virtual memory

[] create attribute index on join field

v Choose which fields are joined

] GEO_MATCH B

[] BTOTL_2000
] BOOO4_2000
] BOS09_2000 @

L e o O O T ¥

w X Custom field name prefix

—  Press OK.

— You will now see that the Layer properties window shows you that TZZA_adm2_pop
has been joined to Tanzania_adm2
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,f' Layer Properties - Tanzania_adm?2 | Joins | Y || £ |
&, General | |Join layer |Join field Target field | Memory cache |Preﬁx |Joined fields |
Styl l TZA adm2_pop ED MATCH ED MATCH + a_II ]
Style
Labels
Fields
Rendering
B‘j Joins @ Style ~ Cancel Apply Help
— Press OK.

4. View your join
— Open the attribute table for Tanzania_adm2 and ensure that the population data
has successfully joined the boundary data
— This join is temporary and can be deleted at any time by clicking the ‘red minus’ in
the Joins tab of the layer Properties.

5. Save your join as a new shapefile dataset.
— Right click on Tanzania_adm?2 and click Save as
— Save it as an ESRI shapefile
— Save it in this location: C:\Intro_Quantum_GIS\Exercises\Data\Output_data
— Callit Tanzania_adm2_pop
— Tick Add saved file to map
— Leave all other settings as they are
— Click Ok

6. View attributes for your new shapefile.
— Open the attribute table for this new layer. Notice it holds all of the population and
demographic data from join you created.
— Open up the properties for this new layer and look at the Joins tab. You will see that
there is no join. This means that you have now made a permanent dataset
containing the attributes of both Tanzania_adm2 and TZA_adm2_pop.

7. Remove the original pre-joined tables
— Right-click on Tanzania_adm?2 and click Remove.
— Right-click on TZA_adm2_pop and click Remove.

Challenge

Refer back to exercise 3 and style your data with a graduated symbology, to represent variable
population counts in counties of Tanzania. You can choose to symbolise any of the population age
group fields. Also, see if you can display labels showing the admin level 2 names. Your map may look
something like the illustration below... (Note: before attempting this, to simplify the map, untick the
checkbox next to group layer OSM)
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7 QGIS 218.13 - Exercise_4
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Part 6 — Data preparation: Plotting X,Y coordinate locations from a text file.

We will now look at the second type of raw table data that is typically distributed for use in GIS
analysis. You will be presented with a table containing the coordinate locations of Tanzanian Health
Facilities. The data is freely available from the Humanitarian Data Exchange (humdata.org).

1. In Windows Explorer Locate the following CSV data file and open it in Microsoft Notepad,;
then inspect the data:

C:\Intro_Quantum_GIS\Exercises\Data\Tables\TZA_healthfacilities.csv

— Asinthe previous section, the data format is Comma Separated Values (.csv). It is
important to understand the structure of this raw data as it is commonly used for sharing
and distributing raw data. In Notepad, notice how each bit of data is separated by a
comma. This type of format is known as delimited text format. Delimited text files
typically use commas to structure the data, however other delimiter characters are also
in use, such as space or tab. Provided that the delimiter is applied consistently, the data
can then be formed into a table with rows and columns within a GIS or any other table-
based software.

— Close Notepad.
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2. Add this .csv file to QGIS

— Returning to the current QGIS project, start by turning off labels for the layer
Tanzania_adm2_pop, to avoid confusion

— On the Manage Layers toolbar, click on the Add Delimited Text Layer button.

— Click on Browse and add:
C:\Intro_Quantum_GIS\Exercises\Data\Tables\TZA_healthfacilities.csv

— Inthe file format section, ensure CSV is selected

— Setthe Xand Y fields are correctly set

— The window should look like this:

,f Create a Layer from a Delimited Text File | 2 || ¢ |
File Name C:/GMH/UGANDA/TZA_healthfacilities.csv
Layer name TZA_healthfacilities Encoding [UTI‘—S 'l
File format @ CsV (comma separated values) () Custom delimiters () Regular expression delimiter

Record options Number of header lines to discard 0 = First record has field names

Field options [| Trim fields || Discard empty fields || Decimal separator is comma
Geometry definition (@) Point coordinates (") well known text (WKT) () No geometry (attribute only table)
X field Y field ["] pMS coordinates
Layer settings [] Use spatial index [] Use subset index [] watch file
X Y date_maodified name what3worc
1 32.82869 -5.05716 2016-05-20T18:16:41.338Z 202 KJ escalated.chopperintc| =

2 39.15133 -6.88878 2016-05-20T18:16:41.338Z 511 KJ GONGO LA MBOTO doll.extremely.accomg

3 32.91911 -2.58227 2016-05-20T18:16:41.338Z 512 K2 twitchy.ooze.motoring
4 39.27917 -6.809073  2016-05-20718:16:41.338Z 909 DENTAL CENTRE labels.transit.unearthl
5 34304 -8.67632 2016-05-20T18:16:41.338Z A AND A cherub.bestowing.ren
6 34.30385215 -8.67629975 2016-05-16T07:12:52Z A And A unbothered.concentra ~
4 ] b
oK ] [ Cancel ] [ Help

— You will notice that the table preview section at the bottom of the window changes
if you change the options

— Press OK.

— If a window pops up asking you to select a Coordinate Reference System, select
‘WGS 84 / EPSG 4326°. (N.B. use the filter input box to help you search)

— Press OK.

— You will notice that a number of points have now appeared on your map canvas and
TZA_healthfacilities point layer is visible in your Layers panel.
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ﬁ > ] [ OSM data
o 3 .
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o’ [] 42656.0000 - 324414.8000
@ - [ 324414.8000 - 606173.6000
] 606173.6000 - 887932.4000
% [ @87932.4000 - 1169691.2000
Wa - B 11696912000 - 1451450.0000
> O] ) HLLsHADE
o 2 D Iil TrueMarble
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Ak
—
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‘\\
Coordinate 4664802,-1306759 % Scale 1:9,400,306 H Magnifier 100% < Rotation 0.0 = Render @EPSG:BES? (OTF) Q

— This point layer is a temporary layer which is taking all of its data straight from the
text file. It is not yet a permanent geometry layer.

— You can confirm this by right clicking on the layer in the Layers window and selecting
Properties. If you look at the Metadata tab, the ‘Source for this layer’ is still pointing
to the text file and has a line of code there to tell it to plot the points from scratch
every time you open the QGIS project.

— This temporary plot of the locations has limitations for further analysis. It is really
only intended for temporary visualisation and typically a GIS analyst would save the
locations into a standalone spatial dataset, e.g. a shapefile; we will do this next.

— Now close the Layer Properties window.
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3. Save your temporary table into a permanent spatial dataset.
— Right click on your point layer in the Layer window and select Save as.
— From the Format dropdown select ESRI Shapefile.
— Inthe Save as dialogue click on Browse and browse to:
C:\Intro_Quantum_GIS\Exercises\Data\Output_data
— Call it TZA_health_facilities_locations
— Tick Add saved file to map
— Leave all other settings as they are

— Click Ok
/' Save vector layer as.. | ¥ || &3 |
Format [ESRl Shapefile V]
File name  C:\Intro_Quantum_GIS\Exercises\Data\Output_data\TZA_health_facilities_locations.shp
Layer name
CRS Selected CRS (EPSG:4326, WGS 84)
Encoding [S'_.rstem v]

Save only selected features
P Select fields to export and their export options

Add saved file to map

Symbology export No symbology -
Scale 1:50000
P Geometry

b [ ] Extent (current: layer)
P Layer Options

P Custom Options

ok || cancel || hep

—  You will see a temporary message telling you that the export has been completed.
— Note that the new layer has appeared in your Layers Panel and use Windows
Explorer to note the dataset location

4. You should now remove the temporary TZA_healthfacilities layer from your QGIS project, as
it is no longer required.

— Right click on the TZA_healthfacilities layer in the Layers window and click on
Remove
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